
EVM User's Guide: MSP-EXP430FR5994
MSP430FR5994 LaunchPad™ 开发套件 
(MSP‑EXP430FR5994)

摘要

MSP-EXP430FR5994 LaunchPad™ 开发套件是适用于 MSP430FR5994 微控制器 (MCU) 的易用型评估模块 

(EVM)。它包含在超低功耗 MSP430FRx FRAM 微控制器平台上开始开发所需要的全部资源，包括用于编程、调

试和能量测量的板载调试探针。图 1-1 显示了该开发套件。

图 1-1. MSP-EXP430FR5994 LaunchPad 开发套件
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1 开始

1.1 引言

MSP-EXP430FR5994 LaunchPad 开发套件是适用于 MSP430FR5994 微控制器 (MCU) 的易用型评估模块 

(EVM)。该 LaunchPad 开发套件包含在超低功耗 MSP430FRx FRAM 微控制器平台上开始开发所需要的全部资

源，包括用于编程、调试和能量测量的板载调试探针。该电路板具有用于快速集成简单用户界面的板载按钮和 

LED、一个用于连接 microSD 卡的 microSD 卡端口以及一个支持独立应用（无需外部电源）的超级电容器。

MSP430FR5994 MCU 采用 256KB 的嵌入式 FRAM（铁电随机存取存储器），这是一种以超低功耗、高擦写次

数和高速写入访问而闻名的非易失性存储器。该器件还采用 8KB 的 SRAM，支持高达 16MHz 的 CPU 速度，并

具有通信外设、ADC、计时器、AES 加密、低功耗加速器（LEA，是 FRAM 系列的新硬件模块，专为快速、高

效、低功耗的矢量数学运算而设计）等集成外设，可帮助您开始进行开发。

40 引脚 BoosterPack™ 插件模块接头简化了快速原型设计，支持市面上的多种 BoosterPack 模块。您可以快速添

加无线连接、图形显示、环境检测等功能。您还可以设计您自己的 BoosterPack 插件模块，或者从 TI 和第三方开

发商已提供的众多插件模块中进行选择。

还提供了免费的软件开发工具，例如 TI 基于 Eclipse 的 Code Composer Studio™ IDE (CCS) 和适用于 MSP430™ 

的 IAR Embedded Workbench® IDE (EW430)。与 MSP430FR5994 LaunchPad 套件配合使用时，这两种 IDE 都
支持用于进行实时功耗性能评测和调试的 EnergyTrace++™ 技术。

1.2 关键特性

• 基于 MSP ULP FRAM 技术的 MSP430FR5994 16 位 MCU
• 可用于超低功耗调试的 EnergyTrace++ 技术

• 利用 BoosterPack 插件模块生态系统的 40 引脚 LaunchPad 开发套件标准

• 板载 eZ-FET 调试探针

• 两个按钮和两个 LED，用于用户交互

• 板载 microSD 卡
• 超级电容器 (0.22F)

备注
自 2022 年起，不再安装用于 MSP-EXP430FR5994 的 microSD 卡插槽。本文档的其余部分仍然引用

了 microSD 卡插槽，以支持 2022 年之前制造的电路板。

1.3 包含的内容

1.3.1 套件内容

• MSP-EXP430FR5994 LaunchPad 开发套件

• Micro-USB 电缆

• 快速入门指南

1.3.2 软件示例

• 开包即用软件
• LED 闪烁

• 音频 BoosterPack 插件模块录音和播放

• 用于信号处理的低功耗加速器
• EEPROM 仿真

1.4 初始步骤：开箱即用体验

使用预编程的开箱即用代码是熟悉 EVM 的一种简便方法。该代码从用户角度演示了一些关键功能。

1.4.1 连接至计算机

使用随附的 USB 电缆将 LaunchPad 开发套件连接至计算机。随后应该会亮起绿色的电源 LED 指示灯。为确保正

确运行，需要使用驱动程序。TI 建议通过安装 TI CCS 或 IAR EW430 等 IDE 来安装驱动程序。此外也可从 

ti.com/MSPdrivers 获取驱动程序。
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1.4.2 运行开箱即用演示

连接到计算机后，LaunchPad 开发套件会上电。同时按住 S1 和 S2 按钮可选择新模式。有关每种模式的详细说

明，请参阅节 3.1。

1.4.2.1 实时温度模式

该模式向 PC GUI 提供实时温度数据流。您可以影响器件的温度并在 GUI 上查看温度变化。

1.4.2.2 FRAM 数据日志模式

该模式显示 MSP430FR5994 的 FRAM 数据记录功能。启动该模式后，LaunchPad 开发套件每隔五秒从睡眠模式

唤醒一次（通过 LED 闪烁进行指示），以记录温度和输入电压值。在重新连接到 GUI 之后，可以在 GUI 中上传

这些值并用图表展示这些值。

1.4.2.3 SD 卡数据日志模式

该模式显示了 MSP430FR5994 在与 SD 卡连接时的数据记录功能。启动该模式后，LaunchPad 开发套件每隔五

秒从睡眠模式唤醒一次（通过 LED 闪烁进行指示），以记录温度和输入电压值。在重新连接到 GUI 之后，可以在 

GUI 中上传这些值并用图表展示这些值。

1.5 后续步骤：查看提供的代码

了解评估模块 (EVM) 特性之后，您便可以开启有趣的开发之旅。现在应该打开一个集成开发环境并开始编辑代码

示例了。有关可用的 IDE 及其下载位置，请参阅节 4。

开始使用 LaunchPad 开发套件的最快方法是使用 TI 的云开发工具。基于云的 Resource Explorer 提供对 

MSPWare 中所有示例和资源的访问。Code Composer Studio Cloud 是一款简单的基于云的 IDE，支持在 

LaunchPad 开发套件上开发和运行应用程序。

下载页面中提供了开箱即用的源代码和更多代码示例。代码已获得 BSD 许可，TI 鼓励用户重复使用和修改这些代

码，以满足特定的需求。

节 3 详细介绍了所有函数并提供了工程结构以帮助您熟悉代码。

通过使用板载 eZ-FET 调试探针，调试和下载新代码变得非常简单。仅需通过提供的 USB 电缆在 EVM 和 PC 之
间建立 USB 连接。
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2 硬件

图 2-1 显示了 MSP-EXP430FR5994 硬件概览。

图 2-1. MSP-EXP430FR5994 概览

2.1 框图

图 2-2 显示了方框图。
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Reset 
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EnergyTrace 
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图 2-2. MSP-EXP430FR5994 方框图

2.2 硬件特性

2.2.1 MSP430FR5994 MCU

MSP430FR5994 是 TI 全新 ULP FRAM 技术平台中的新一代器件。FRAM 是一种尖端存储技术，将闪存和 RAM 
的最佳特性融入到单一非易失性存储器中。更多有关 FRAM 的信息，请参阅 www.ti.com/fram。

器件特性包括：

• 1.8V 至 3.6V 的工作电压

• 16 位 RISC 架构，高达 16MHz 系统时钟和 8MHz FRAM 访问

• 256KB FRAM 和 8KB 静态随机存取存储器 (SRAM)
• 16 通道 12 位 ADC
• 16 通道模拟比较器

• 六个 16 位计时器，每个计时器具有七个捕捉/比较寄存器

• 6 通道直接存储器存 (DMA)
• 128 位或 256 位 AES
• 32 位硬件乘法器 (MPY)
• 68 个通用输入输出 (GPIO)

图 2-3 显示了采用 80 引脚 PN 封装的 MSP430FR5994 MCU 的引脚排列。
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图 2-3. MSP430FR5994 引脚排列

2.2.2 采用 EnergyTrace++ 技术的 eZ-FET 板载调试探针

为了保持开发便利性和成本效益，TI 的 LaunchPad 开发套件集成了板载调试探针，从而免除了高薪聘请编程人员

之忧。MSP-EXP430FR5994 具有 eZ-FET 调试探针（请参阅图 2-4），这是一款简单且成本很低的调试器，支持

所有 MSP430 器件衍生产品。
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图 2-4. eZ-FET 调试探针

MSP-EXP430FR5994 LaunchPad 开发套件采用完整的 EnergyTrace++ 技术。EnergyTrace™ 功能在 MSP 产品

系列中有所不同（请参阅表 2-1）。

表 2-1. EnergyTrace 技术

特性 EnergyTrace™ 技术 EnergyTrace++™ 技术

电流监控 ✓ ✓
CPU 状态 ✓

外设和系统状态 ✓

支持的器件 所有 MSP430 MCU FR59xx 和 FR69xx MCU

所需的开发工具 MSP-FET 或 eZ-FET MSP-FET 或 eZ-FET

在图 2-4 中，穿过 J101 的虚线将 eZ-FET 调试探针与目标区域分开。可以通过 J101（隔离跳线块）上的跳线断

开穿过这条线的信号。有关隔离跳线块的更多详细信息，请参阅节 2.2.3。

eZ-FET 调试探针还提供了与主机的“反向通道”UART-over-USB 连接，这在调试过程中非常有用，并且有助于

轻松地与 PC 进行通信。有关详细信息，请参阅节 2.2.4。

有关 eZ-FET 硬件的详细信息，请参阅节 6 中的原理图和硬件设计文件下载页面。有关调试器的软件和更多信

息，请访问 eZ-FET wiki。

2.2.3 调试探针连接：隔离跳线块

跳线 J101 处的隔离跳线块可以连接或断开从 eZ-FET 域进入 MSP430FR5994 目标域的信号。这包括 eZ-FET 
Spy-Bi-Wire 信号、应用程序 UART 信号以及 3.3V 和 5V 电源（请参阅表 2-2 和图 2-5）。

断开上述连接的原因：

• 完全消除 eZ-FET 调试探针的影响，以实现高精度目标功率测量

• 控制 eZ-FET 和目标域之间的 3V 和 5V 功率流

• 释放目标 MCU 引脚，用于除板载调试和应用 UART 通信以外的其他目的

• 提供 eZ-FET 的编程和 UART 接口，使其可用于板载 MCU 以外的器件。
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表 2-2. 隔离块连接

跳线 说明

GND 接地

5V 通过 USB 提供 5V VBUS

3V3 3.3V 电压轨，源自 eZ-FET 域中的 VBUS。

RXD << 反向通道 UART：目标 MSP430FR5994 通过该信号接收数据。箭头指示信号的方向。

TXD >> 反向通道 UART：目标 MSP430FR5994 通过该信号发送数据。箭头指示信号的方向。

SBW RST Spy-Bi-Wire 调试：SBWTDIO 数据信号。该引脚还用作 RST 信号（低电平有效）。

SBW TST Spy-Bi-Wire 调试：SBWTCK 时钟信号。该引脚也用作 TST 信号。
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图 2-5. eZ-FET 隔离跳线方框图

2.2.4 应用程序（或反向通道）UART

借助该反向通道 UART，可以与不属于目标应用主要功能的 USB 主机进行通信。这在开发过程中非常有用，而且

还能提供与 PC 主机侧进行通信的通道。这可以用于在与 LaunchPad 开发套件通信的 PC 上创建图形用户界面 

(GUI) 和其他程序。

图 2-5 显示了反向通道 UART 的通道。反向通道 UART 是 eUSCI_A0 上的 UART。该 UART 通道独立于 40 引脚 

BoosterPack 插件模块连接器 (eUSCI_A3) 上的 UART。

在主机侧，当 LaunchPad 开发套件在主机上进行枚举时，将生成一个用于应用反向通道 UART 的虚拟 COM 端
口。您可以使用任何与 COM 端口连接的 PC 应用程序（包括 Hyperterminal 或 Docklight 等终端应用程序）来打
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开该端口并与目标应用程序通信。用户需要找出对应于反向通道的 COM 端口。在 Windows PC 上，设备管理器

可以提供帮助（请参阅图 2-6）。

图 2-6. 设备管理器中的应用反向通道 UART

反向通道 UART 是 MSP Application UART1 (COM13) 端口。此时，图 2-6 显示了 COM13，但该端口可能因主机 

PC 而异。确定正确的 COM 端口并根据相关文档在主机应用程序中配置该端口。然后，打开该端口并使主机开始

与其进行通信。

在目标 MSP430FR5994 侧，反向通道连接到 eUSCI_A0 模块。eZ-FET 具有可配置的波特率；因此，PC 应用程

序配置的波特率务必与在 eUSCI_A0 上配置的波特率相同。

2.2.5 特殊特性

2.2.5.1 microSD 卡

MSP430FR5994 LaunchPad 开发套件具有板载 microSD 卡。SD 卡为用户提供了另一种廉价的数据记录方法。

该卡开箱即用，随附一个 SD 卡库，可帮助用户将 MSP430FR5994 与 SD 卡连接在一起。用户可以利用该库将数

据存储在文件中并使用他们选择的名称为文件命名，以便以后可以将数据与 PC 结合使用。

插槽可以检测卡是否存在。如果在 MSP430FR5994 开启时插入卡，则会为 MCU 生成一个中断。表 2-3 列出了 

SD 卡检测引脚和用于与 SD 卡通信的其余引脚分配情况。

表 2-3. microSD 卡至 MCU 连接

microSD 卡功能 MSP430FR5994 引脚

SD 卡检测 P7.2

SD SPI MOSI P1.6

SD SPI MISO P1.7

SD SPI CS P4.0

SD SPI CLK P2.2

MSP430FR5994 LaunchPad 开发套件上的 R7 未安装在电路板上，以确保准确地测量 LPM 电流。在软件中使用

内部 MSP 上拉电阻器，或安装 R7。

R5 也未安装。在 SD 卡库中、SPI CS 线路被驱动为高电平或低电平。通常，包含 R5 等上拉电阻器是为了在系

统启动期间使用。在 MSP430FR5994 完全启动并在 CS 线路上输出高电平信号之前，CS 可能会悬空，SD 卡可

能会将其他悬空 SPI 线路解释为通信。对于无法控制确切启动条件的应用程序，安装该电阻器一种很好的做法。

对于 LaunchPad 开发套件，当所有 GPIO 都设置为低电平时，移除该电阻器以进行精确的电流测量。

2.2.5.2 220mF 超级电容器

电路板上安装了一个 220mF (0.22F) 电容器，无需任何外部电源即可为系统供电。该超级电容器可通过以下方式

使用：充电、使用（直接连接至 3V3 电源轨）和断开连接。有关这些使用模式以及各模式使用方法的详细信息，
请参阅节 2.3。

2.3 电源

该电路板旨可适应各种供电方法，包括通过板载 eZ-FET 和外部或 BoosterPack 插件模块电源供电（请参阅图 

2-7）。
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图 2-7. MSP-EXP430FR5994 电源方框图

2.3.1 eZ-FET USB 电源

较为常见的电源方案是通过 eZ-FET 调试器从 USB 进行供电。这种方案可从 USB 提供 5V 电源并且还可将该电

源轨调节为 3.3V 以用于 eZ-FET 运行，此外，还为 LaunchPad 开发套件的目标侧提供 3.3V 的电源。eZ-FET 提
供的电源由跳线 J101 进行控制。要实现 3.3V 电源，请确保将跳线连接在 J101 3V3 端子上。

2.3.2 BoosterPack 插接模块和外部电源

板上的接头 J6 直接提供外部电源。提供外部电源时应遵守器件电压运行规格。MSP430FR5994 的工作电压范围

为 1.8V 至 3.6V。有关详细信息，请参阅 MSP430FR5994 数据表。
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图 2-8. MSP-EXP430FR5994 超级电容器电源方框图

2.3.3 超级电容器 (C1)

电路板上安装了一个 220mF (0.22F) 超级电容器，无需任何外部电源即可为系统供电。这展示了 MSP430FR5994 
目标 MCU 的超低功耗。看看您可以单独依靠超级电容器使您的应用程序运行多长时间！

2.3.3.1 为超级电容器充电

当 EVM 插入 PC 或电路板由外部供电时，可以为超级电容器充电。在充电期间，将 J8 设置为充电模式，这将添

加一个用于充电的限流电阻器。

要为超级电容器充电，电源必须来自 eZ-FET 调试探针、外部电源（通过 J5）或 BoosterPack 插件模块（通过 J1 
供电）。使超级电容器充电两到三分钟（时间可能因超级电容器的初始电量和电源而异）以完全充至 VCC。

2.3.3.2 使用超级电容器

超级电容器充电后，将 J8 跳线移至“使用”设置并拔下电源。这样无需充电电阻器就可以将超级电容器连接至 

3V3 电源轨。现在，LaunchPad 开发套件完全由 C1 超级电容器供电。

要实现最低功耗操作，请确保断开 J101 跳线并在未使用 microSD 卡的情况下将其取出。移除 J101 跳线可防止超

级电容器为 eZ-FET 电路供电，从而防止消耗额外的电力。microSD 卡在插入系统时消耗大约 100µA 的电流，即

使该卡未使用也是如此。通过执行这些步骤，可以仅通过超级电容器为您的应用供电更长时间。

2.3.3.3 禁用超级电容器

通过移除 J8 跳线，可以将超级电容器与电路板完全分离。将该跳线仅挂在一个引脚上，以防止跳线丢失。

2.4 测量 MSP430 电流消耗

要使用万用表测量 MSP430FR5994 的电流消耗，请使用 J101 跳线隔离块上的 3V3 跳线。测量的电流包括目标

器件消耗的电流以及任何通过 BoosterPack 插接模块插座消耗的电流。
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要测量超低功耗，请按照下列步骤操作：

1. 拆下 J101 隔离块中的 3V3 跳线，并在该跳线上连接一个电流表。

2. 应考虑反向通道 UART 和任何连接到 MSP430FR5994 的电路可能对电流消耗产生的影响。考虑在隔离跳线

块上断开这些器件和电路，或者至少在最终测量中考虑其灌电流和拉电流能力。

3. 确保 MSP430FR5994 上没有悬空输入或输出 (I/O)。这些会引起不必要的额外电流消耗。每个 I/O 都应该进

行驱动，如果是输入，应该将其拉/驱动至高电平或低电平。

4. 开始执行目标。

5. 测量电流。请记住，如果电流出现波动，可能难以获得稳定的测量结果。在静态状态下进行测量更容易一些。

或者，可以使用 EnergyTrace++ 技术来测量相同的电流，并通过 CCS 和 IAR 中的集成 GUI 查看能量曲线。利用 

EnergyTrace，您可以比较各种电流曲线并更好地优化能耗性能。

2.5 计时

除器件中的内部时钟之外，MSP-EXP430FR5994 还提供外部时钟。

• 问题 1：32kHz Epson 晶振 (FC-135R)
• 问题 2：DNP 高频晶振空间

32kHz 晶振可实现比其他低频时钟源更低的 LPM3 睡眠电流。因此，有了该晶振就可以使用全范围的低功耗模

式。

默认情况下不安装高频晶体，但提供了用于安装晶振的空间。应该为需要比内部 DCO 更精确的高频时钟源的应用

安装高频晶振。

器件中的内部时钟默认采用以下配置：

• MCLK：DCO 1MHz
• SMCLK：DCO 1MHz
• ACLK：REFO 32.768kHz

有关配置内部时钟和使用外部振荡器的更多信息，请参阅 MSP430FR58xx、MSP430FR59xx 和 MSP430FR6xx 
系列用户指南。

2.6 将 eZ-FET 调试探针用于不同的目标

LaunchPad 开发套件上的 eZ-FET 调试探针可以连接到大多数 MSP430 衍生器件，而不仅仅是板载 

MSP430FR5994 目标器件。

要连接这些衍生器件，请断开隔离跳线块中的每根跳线。该操作是必要的，因为调试探针无法通过 Spy-Bi-Wire 
(SBW) 连接一次连接到多个目标。

接下来，确保目标板具有正确的 SBW 连接。为了与 SBW 兼容，RST/SBWTDIO 上的电容器不能大于 2.2nF。
MSP430 JTAG 接口电路设计文档是 MSP430 硬件工具用户指南。

最后，用导线将隔离跳线块调试探针侧的这些信号一起连接到目标硬件：

• 5V（如果需要 5V）
• 3.3V
• GND
• SBWTDIO
• SBWTCK
• TXD（如果要使用 UART 反向通道）
• RXD（如果要使用 UART 反向通道）

该接线可以使用跳线完成，也可以通过设计具有插入隔离跳线块的连接器的电路板来完成。

2.7 BoosterPack 插接模块引脚布局

该 LaunchPad 开发套件遵循 40 引脚 LaunchPad 开发套件引脚排列标准。对于 TI 生态系统而言，该标准旨在帮

助实现 LaunchPad 开发套件与 BoosterPack 插件模块之间的兼容性。
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40 引脚标准与其他 LaunchPad 开发套件（如 MSP-EXP430FR4133）所采用的 20 引脚标准兼容。这样，便可以

在 20 引脚 LaunchPad 开发套件中使用 40 引脚 BoosterPack 插接模块的一些功能子集。

虽然大多数 BoosterPack 插接模块符合该标准，但仍有些不符合标准。MSP-EXP430FR5994 LaunchPad 开发套

件兼容所有符合标准的 40 引脚 BoosterPack 插件模块。如果 BoosterPack 插件模块的经销商或所有者没有明确

指出其与 MSP-EXP430FR5994 LaunchPad 开发套件的兼容性，请将候选 BoosterPack 插件模块的原理图与 

LaunchPad 开发套件进行比较，以确保兼容性。请记住，有时在软件中更改 MSP430FR5994 MCU 引脚功能配置

即可解决冲突。

要检查设计所需的 BoosterPack 插件模块与您选择的 LaunchPad 开发套件的兼容性，您可以使用 BoosterPack 
Checker 工具（请参阅图 2-9）。利用该工具，您可以选择我们提供的任何 LaunchPad 开发套件，并确定其与我

们提供的任意数量 BoosterPack 插件模块的兼容性。用户还可以添加自己的 BoosterPack 插件模块，以便在进行

下一个原型设计时检查其兼容性。

图 2-9. BoosterPack 插件模块 Checker 工具

图 2-10 显示了 MSP430FR5994 LaunchPad 开发套件 40 引脚的引脚排列。

引脚功能的软件配置在兼容性中起着重要作用。LaunchPad 开发套件的虚线侧仅显示符合标准的适用功能。不

过，每个引脚都具有可由软件配置的其他功能。有关各个引脚功能的更多详细信息，请参阅 MSP430FR5994 数
据表。
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图 2-10. LaunchPad 开发套件至 BoosterPack 插件模块连接器引脚排列

2.8 设计文件

2.8.1 硬件

请参阅节 6 以了解原理图。MSP-EXP430FR5994 设计文件下载页面中提供了所有设计文件，包括原理图、布

局、物料清单 (BOM)、光绘文件和文档。

2.8.2 软件

MSP-EXP430FR5994 设计文件下载页面中提供了所有设计文件，包括 TI-TXT 目标代码固件映像、软件示例工程

和文档。

2.9 硬件更改日志

表 2-4 列出了所有已发布硬件修订版本的更改历史记录。

表 2-4. 硬件更改日志

PCB 版本 说明

版本 1.1 初始发行版

3 软件示例

软件示例随 MSP430FR5994 LaunchPad 开发套件一起提供（请参阅表 3-1），可在 MSP430FR5994 
LaunchPad 开发套件下载页面中找到，也可在用于 MSP 微控制器的 MSP430Ware 中找到。

表 3-1. 软件示例

演示名称 所需的 BoosterPack 说明 更多详细信息

OutOfBox_FR5994 无
出厂时在 LaunchPad 上预编程的开箱即用演示。演示了 

MSP430FR5994 MCU 的功能。
节 3.1

BlinkLED_FR5994 无 以固定的间隔使 LaunchPad 上的 LED 闪烁。 节 3.2

BOOSTXL-
AUDIO_RecordPlaybac
k_MSP430FR5994

• MSP-EXP430FR5994
• BOOSTXL-AUDIO 演示如何使用 DMA 通过 FRAM 存储器录制和播放音频。 节 3.3

硬件 www.ti.com.cn
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表 3-1. 软件示例 (continued)
演示名称 所需的 BoosterPack 说明 更多详细信息

BOOSTXL-
AUDIO_LEA_MSP430
FR5994

• MSP-EXP430FR5994
• BOOSTXL-AUDIO
• 430BOOST-SHARP96 

或 BOOSTXL-
SHARP128

通过执行 FFT 和 FIR 演示 MSP 低功耗加速器 (LEA) 的性能。 节 3.4

EEPROM 仿真参考设

计
• MSP-EXP430FR5994 在支持 I2C 和 SPI 的 MSP 上使用 FRAM 技术模拟 EEPROM 节 3.5

要将任何软件示例与 LaunchPad 套件一起使用，您必须具有支持 MSP430FR5994 MCU 的集成开发环境 (IDE)。
表 3-2 列出了最低 IDE 要求。

表 3-2. MSP-EXP430FR5994 的最低 IDE 要求

Code Composer Studio™ IDE IAR Embedded Workbench® IDE

Code Composer Studio IDE v6.1.3 或更高版本 适用于 MSP430 的 IAR Embedded Workbench v6.40.2 或更高版本

有关如何快速入门以及最新版 Code Composer Studio 和 IAR Embedded Workbench IDE 下载地址的更多详细信

息，请参阅节 4。

3.1 开箱即用的软件示例

本节介绍 EVM 中预装载的开箱即用软件的功能和结构。

3.1.1 源文件结构

该工程包含多个文件。这种组织方式便于工程导航，也方便将该工程的部分文件重复用于其他工程。表 3-3 介绍

了该工程中的每个文件。

表 3-3. 源文件和文件夹

名称 说明

main.c 开箱即用演示主函数、初始化、共享 ISR 等

LiveTempMode.c 包含实时温度流模式函数

FRAMLogMode.c 包含 FRAM 数据记录模式函数

SDCardLogMode.c 包含 SD 卡数据记录模式函数

库：Driverlib 器件驱动程序库

库：FatFs 适用于小型嵌入式系统的通用 FAT 文件系统模块 (FatFs)

HAL/HAL_SDCard.c 用于板/器件到 SD 卡连接的硬件抽象层

库：SDCardLib 用于提供更高级别 SD 卡 API 的包装器库

3.1.2 开箱即用演示 GUI

需要使用开箱即用演示 GUI（请参阅图 3-1）来控制 MSP-EXP430FR5994 LaunchPad 开发套件上运行的开箱即

用应用程序。可以在最新的 MSPWare 安装或 MSP-EXP430FR5994_Software_Examples.zip（可从 MSP-
EXP430FR5994 设计文件下载页面获取）中找到该 GUI。
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图 3-1. MSP-EXP430FR5994 开箱即用演示 GUI

首先点击“Connect”按钮，然后选择正确的串行 COM 端口 (MSP Application UART1) 并点击“Open”按钮，
以建立与 LaunchPad 开发套件的连接。在 Windows 上，打开“设备管理器”→“端口 (COM 和 LPT)”以验证

反向通道 UART 的相应 COM 端口。

建立连接后，GUI 每隔几秒对 LaunchPad 开发套件执行一次 ping 操作，以确保其仍然存在并保持串行端口打

开。如果未收到 LaunchPad 开发套件的响应，GUI 会自动关闭串行端口连接。

3.1.3 上电和空闲

当 LaunchPad 开发套件在连接到计算机后上电时，红色和绿色 LED 会切换多次，以指示开箱即用演示正在运

行。然后 MSP430FR5994 进入低功耗模式 3 以等待来自 PC GUI 的 UART 命令。
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3.1.4 实时温度模式

要进入实时温度模式，请点击 GUI“Application Controls”面板中“Live Temp Mode”下方的“Start”按钮（请

参阅图 3-2）。

图 3-2. 实时温度模式

MSP430FR5994 首先将温度传感器的两个 ADC 校准常数发送至 PC GUI。然后，它设置其 12 位 ADC 以对来自

其内部温度传感器的信号进行采样和转换。还配置了一个硬件计时器，以在器件进入低功耗模式 3 之前每 0.125 
秒触发一次 ADC 转换，从而节省电力。ADC 采样和转换完成后，原始 ADC 数据将通过 UART 反向通道发送至 

PC GUI。

当 PC GUI 接收到原始 ADC 数据时，首先计算以摄氏度和华氏度为单位的值。PC GUI 具有一个缓冲区，用于保

存最近 100 次的温度测量值，这些测量值根据 PC 的当前时间绘制在“Incoming Data”面板上。

数据图上会绘制一条红色水平线，以指示传入数据的移动平均值。

要退出该模式，请点击“Live Temp Mode”下方的“Stop”按钮。您必须先退出该模式才能启动其他模式。
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3.1.5 FRAM 日志模式

要进入 FRAM 日志模式，请点击 GUI“Application Controls”面板中“FRAM Log Mode”下方的“Start”按

钮。PC GUI 还通过 UART 发送其当前时间戳以存储在 LaunchPad 开发套件中。该时间戳稍后用于在 FRAM 记
录的数据传输到 GUI 时推断 X 轴时间值（请参阅图 3-3）。

图 3-3. FRAM 日志模式

当 MSP430FR5994 从 GUI 接收到 UART 命令时，它通过初始化实时时钟以每 5 秒触发一次中断来启动进入序

列。红色 LED 闪烁三次，表示成功进入 FRAM 日志模式。

MSP430FR5994 每 5 秒从低功耗模式 3 唤醒一次以执行数据记录，然后再返回低功耗模式 3。在进入 FRAM 日
志模式后，GUI 会自动断开与 LaunchPad 开发套件的连接。每次唤醒器件时，绿色 LED 都会亮起，以指示存储

了数据点。分配了两个 10000 长 FRAM 阵列缓冲器来存储原始 ADC 输出数据。

由于该器件可以由板载超级电容器单独供电，因此 12 位 ADC 被设置为对来自其内部温度传感器和电池监测器的

信号（超级电容器电压）进行采样和转换。

该板允许使用 USB 电缆或板载超级电容器为应用程序供电。有关超级电容器的更多详细信息，请参阅节 2.3.3。
切换到超级电容器：

1. 在电路板通过 USB 供电时，将 J8 上的跳线配置为“充电”。等待 2 至 3 分钟。

2. 启动 FRAM 记录。

3. 将 J8 上的跳线切换为“使用”。

4. 断开 J101 上的 SBWTDIO 和 3v3 跳线（以防止为 eZ-FET 反向供电）。

5. 断开 USB。

备注

使用超级电容器时，从支架上取下 SD 卡以降低功耗，从而延长应用程序运行时间。
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要退出 FRAM 日志模式，请按 LaunchPad 开发套件上的 S2（右侧）按钮。红色 LED 短暂亮起，表示成功退出

并返回至上电和空闲状态。将跳线重新连接至默认位置并连接 USB。在 GUI 中重新打开 LaunchPad 开发套件的

串行端口。点击“Transfer FRAM Data”按钮将记录的温度和电压数据从器件 FRAM 传输至 PC。

3.1.6 SD 卡日志模式

SD 卡模式的工作方式与 FRAM 日志模式类似，不同之处在于温度和电压数据存储在 SD 卡上的 .txt 文件中。每

次启动 SD 卡日志模式时，都会在 /root/DATA_LOG/ 下创建一个新的 LOG_#.TXT（# 会随着下一个文件的出现而

递增）。

可以按照与进入和退出 FRAM 日志模式相同的方式进入和退出 SD 卡日志模式。点击“Show SD Card Data”可

将数据从最近创建的 LOG_#.TXT 传输到 PC。

备注

超级电容器无法长时间为 SD 卡日志模式供电，因为 SD 卡消耗的电量要多得多。

3.2 LED 闪烁示例

该简单的软件示例演示了如何通过软件切换 GPIO 以使 LaunchPad 套件上的 LED 闪烁。

3.2.1 源文件结构

工程可以拆分为多个文件（请参阅表 3-4）。这样便于工程导航，也方便将该工程的部分文件重复用于其他工程。

表 3-4. 源文件和文件夹

名称 说明

main.c LED 闪烁主函数

库：Driverlib 器件驱动程序库

主代码使用 MSP430 驱动程序库来停止看门狗计时器并在软件循环中配置/切换连接到 LED 的 P1.0 GPIO 引脚。
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3.3 BOOSTXL-AUDIO 音频录音和播放示例

本节介绍 BOOSTXL-AUDIO_RecordPlayback_MSP430FR5994 演示的功能的和结构，该演示包含在 MSP-
EXP430FR5994 软件示例下载文件中，也可以通过 MSPWare（请参阅节 4.3）更轻松地获取。

3.3.1 源文件结构

工程可以拆分为多个文件（请参阅表 3-5）。这样便于工程导航，也方便将该工程的部分文件重复用于其他工程。

表 3-5. 源文件和文件夹

名称 说明

main.c 演示的时钟、GPIO、DAC 和中断配置。

application/application.c 主应用程序循环和中断服务例程

application/audio_collect.c 设置、启动、停止和关闭音频收集功能

application/audio_playback.c 设置、启动和停止播放功能和中断服务例程

application/dac8311.c 板载 SPI DAC 的工作模式/功能

application/global.h 全局变量定义

Library: driverlib 器件驱动程序库

3.3.2 操作

该演示使用 MSP430FR5994 MCU 上的内置 ADC12 从音频信号处理 BoosterPack 插件模块上的模拟麦克风输出

进行采样。通过使用直接存储器存取 (DMA)，可以在 FRAM 存储器中存储 12 位麦克风数据并从中检索这些数

据。在播放期间，麦克风数据通过 SPI 发送至板载 DAC，以驱动板载扬声器或耳机的音频输出。

要开始录制音频样本，请按 MSP-EXP430FR5994 上的开关 S1（请参阅图 3-4）。LED1 在录制音频时亮起，在

录制阶段完成后熄灭。带有内联麦克风的耳机可用于录制音频。当耳机插入提供的插孔 (J6) 时，BoosterPack 插
件模块会自动检测内联麦克风，并通过内联麦克风（而非板载麦克风）进行录音。

图 3-4. 录音

要播放录制的音频样本，请按 MSP-EXP430FR5994 LaunchPad 开发套件上的开关 S2（请参阅图 3-5）。LED2 
在播放期间亮起，在播放阶段完成后熄灭。要使用耳机收听音频播放，请将耳机插入提供的插孔 J6。
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图 3-5. 播放

3.4 采用 LEA 的滤波和信号处理参考设计示例

本节介绍采用 LEA 的滤波和信号处理参考设计的功能和结构。其软件可以从 TIDM-FILTERING-
SIGNALPROCESSING-LEA 软件进行下载。

3.4.1 源文件结构

工程可以拆分为多个文件（请参阅表 3-6）。这样便于工程导航，也方便将该工程的部分文件重复用于其他工程。

表 3-6. 源文件和文件夹

名称 说明

main.c 演示的时钟、GPIO、显示和中断配置。

application/application.c 主应用程序循环和中断服务例程

application/audio_collect.c 设置、启动、停止和关闭音频收集功能

application/audio_playback.c 设置、启动和停止播放功能和中断服务例程

application/dac8311.c 板载 SPI DAC 的工作模式/功能

application/global.h 全局变量定义

application/fir.c FIR 滤波函数

application/FFT.c 快速傅里叶变换滤波函数

application/FFT_430.asm 以汇编语言表示的 MSP430 快速傅里叶变换滤波函数

application/benchmark.c 性能基准测试计时器和中断服务例程

application/fir_coefficient FIR 系数定义

库：DSPLib MSP430 DSP 库

库：grlib MSP430 图形库

Library: driverlib 器件驱动程序库

3.4.2 操作

该演示是一款 TI 参考设计，重点突出了 MSP430FR5994 MCU 及其集成式低功耗加速器 (LEA) 的信号处理功能

和性能。该示例还使用 430BOOST-SHARP96 或 BOOSTXL-SHARP128 BoosterPack 插件模块来显示音频信号

的滤波输出并充当用户界面。要使用该代码示例，用户必须将音频 BoosterPack 插件模块配置为使用其备用麦克

风电源和输出引脚，方法是将 R1 上的 0 欧姆电阻器移至 R3 并将 R4 移至 R5，如图 3-6 所示。更多有关该示例

的信息，请访问参考设计页面。
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图 3-6. 备用麦克风配置

3.5 仿真 EEPROM 参考设计示例

本节介绍仿真 EEPROM 参考设计的功能和结构。其软件可以从 TIDM-FRAM-EEPROM 软件进行下载。

3.5.1 源文件结构

工程可以拆分为多个文件（请参阅表 3-7）。这样便于工程导航，也方便将该工程的部分文件重复用于其他工程。

表 3-7. 源文件和文件夹

名称 说明

main.c 演示的时钟、GPIO、EEPROM 初始化和中断配置。

eeprom_interface/eeprom_i2c.c EEPROM I2C 接口初始化和函数

eeprom_interface/eeprom_spi.c EEPROM SPI 接口初始化和函数

eeprom_definitions.h 全局变量定义

eeprom.c EEPROM 标准功能

sensing_proc.c 温度和电压采样函数

Library: driverlib 器件驱动程序库

3.5.2 操作

EEPROM 仿真配置为在从模式下使用 I2C 或 SPI 协议，如图 3-7 和图 3-8 所示。它通常会连接到充当主设备的主

机处理器。与传统 EEPROM 不同，该实现不需要在数百字节后进行缓存。通信开始后，主机可以将数据持续写

入存储器。数据会立即写入存储器。这意味着应用程序能够以高得多的吞吐量连续地流式传输数据。SPI 操作还

包括 DMA。

软件示例 www.ti.com.cn
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图 3-7. EEPROM SPI 接口方框图

FRAM EEPROM

Host Processor

MSP430FR5994
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WP
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SDA

VCC

图 3-8. EEPROM I2C 接口方框图

该参考设计还模拟了 I2C 和 SPI 等业界通用 EEPROM 协议以及一个写保护引脚，以确保器件免受任何写入的影

响。在 EEPROM 仿真之上，该参考设计定期对 ADC 进行采样以获得最新的 VCC 和温度，并以低优先级将其存

储在 FRAM 中。当主机应用程序请求这些数据时，这些数据将立即可用。传感器数据当前配置为每秒定期采样，
可针对应用程序进行定制。传感器读数不会阻止 EEPROM 仿真。EEPROM 仿真功能具有最高的优先级。更多有

关该示例的信息，请访问参考设计页面。

4 资源

4.1 集成开发环境

虽然可以使用任意文本编辑器查看源文件，但是如果使用开发环境（如 Code Composer Studio IDE 和 IAR 
Embedded Workbench IDE）打开工程，则可以对工程进行更多操作。

4.1.1 TI 云开发工具

TI 基于云的软件开发工具提供对 MSPWare 内容和基于网络的 IDE 的即时访问。

4.1.1.1 TI 资源浏览器云

TI Resource Explorer Cloud 提供了一个 Web 界面，用于浏览 MSPWare 中的示例、库和文档，而无需将文件下

载到您的本地驱动器（请参阅图 4-1）。

可以立即在 https://dev.ti.com/ 上了解有关 TI Resource Explorer Cloud 的更多信息。

www.ti.com.cn 资源

ZHCUAO6C – MARCH 2016 – REVISED NOVEMBER 2022
Submit Document Feedback

MSP430FR5994 LaunchPad™ 开发套件 (MSP‑EXP430FR5994) 25

English Document: SLAU678
Copyright © 2022 Texas Instruments Incorporated

http://www.ti.com/tool/TIDM-EEPROM-EMULATION
http://www.ti.com/ww/en/launchpad/software.html
http://dev.ti.com/
https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUAO6
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUAO6C&partnum=MSP-EXP430FR5994
https://www.ti.com/lit/pdf/SLAU678


图 4-1. TI 资源浏览器云

4.1.1.2 Code Composer Studio Cloud

Code Composer Studio Cloud (CCS Cloud) 是基于网络的 IDE，支持您为 LaunchPad 开发套件快速创建、编

辑、构建和调试应用程序（请参阅图 4-2）。无需下载和安装大型软件包，只需连接您的 LaunchPad 开发套件即

可开始。您可以从 MSPWare 软件和 Energia 中的大量示例中进行选择，也可以开发您自己的应用程序。CCS 
Cloud 支持调试功能，例如执行控制、断点和查看变量。

如需查看 CCS Cloud 和 CCS Desktop 的完整比较，请点击此处。

立即在 dev.ti.com 上了解有关 Code Composer Studio Cloud 的更多信息。

资源 www.ti.com.cn
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图 4-2. CCS Cloud

4.1.2 Code Composer Studio™ IDE

Code Composer Studio Desktop 是一种专业的集成开发环境，支持 TI 的微控制器和嵌入式处理器产品组合。

Code Composer Studio 包含一整套用于开发和调试嵌入式应用的工具。它包含优化的 C/C++ 编译器、源代码编

辑器、工程构建环境、调试器、分析器以及多种其他功能。

可在 Code Composer Studio (CCS) 集成开发环境 (IDE) 页面了解有关 CCS 的更多信息并进行下载。

要求 CCS v6.1.3 或更高版本。启动 CCS 并选择工作区目录后，使用 Project > Import Existing CCS Eclipse 
Project。将其定位至包含 main.c 的所需演示工程目录（请参阅图 4-3）。
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图 4-3. 使用“Project>Import”功能定位到演示工程

也可以选择 \CCS 子目录。其中包含 CCS 特定的文件。

点击“OK”后，CCS 会识别该工程并允许将其导入。如果工程显示在图 4-4 所示的框中，则表明 CCS 已找到该

工程，该工程左侧会显示复选标记。

图 4-4. CCS 找到工程时

有时 CCS 可以找到工程，但不会显示复选标记。这可能表示工作区中已有同名工程。可以通过重命名或删除该工

程来解决此冲突。即使您在 CCS 工作区中看不到该工程，也要检查文件系统上的工作区目录。

4.1.3 适用于 MSP430 的 IAR Embedded Workbench

适用于 MSP430 的 IAR Embedded Workbench 是另一个非常强大的集成开发环境，支持您开发和管理整个嵌入

式应用程序工程。它集成了 IAR C/C++ 编译器、IAR 汇编器、IAR ILINK 链接器、编辑器、工程管理器、命令行

生成实用程序和 IAR C-SPY® 调试器。

请访问 http://supp.iar.com/Download/SW/?item=EW430-EVAL 以了解有关 IAR Embedded Workbench 的更多信

息和下载该软件。

资源 www.ti.com.cn
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需要 IAR 6.30 或更高版本。若要在 IAR 中打开演示，请点击 File > Open > Workspace…，浏览至所需演示的 

\IAR 子目录中的 *.eww 工作区文件。该文件内包含所有工作区信息。

子目录中还有一个 *.ewp 工程文件。点击“Project > Add-Existing-Project...”，可在现有工作区中打开该文件。

虽然软件示例中包含运行示例所需的所有代码，但 IAR 用户也可以下载并安装 MSPWare，其中包含 MSP430 库
和 TI Resource Explorer。默认情况下，CCS 安装中已包含这些内容。

4.2 LaunchPad 网站

有关 LaunchPad 开发套件、支持的 BoosterPack 插件模块以及可用资源的更多信息，请访问：

• MSP-EXP430FR5994 工具文件夹：专用于该特定 LaunchPad 开发套件的资源

• TI LaunchPad 门户：有关 TI 所有 LaunchPad 套件的信息

4.3 MSPWare 和 TI Resource Explorer
TI Resource Explorer 是一款集成在 CCS 中的工具，用于浏览可用的设计资源（请参阅图 4-5）。TI Resource 
Explorer 可帮助您在包中快速找到所需的内容，包括 MSPWare、ControlSuite、TivaWare 等。TI Resource 
Explorer 组织有序，便于快速找到所有内容，只需点击一下即可将软件工程导入到您的工作区中。

TI Resource Explorer Cloud 是 TI 云开发工具之一，与 CCS Cloud 紧密集成在一起。更多信息请查阅 节 4.1.1。

MSPWare 集合了所有 MSP 器件的代码示例、软件库、数据表和其他设计资源并方便地打包在一起，基本上包含

了开发人员要成为 MSP 专家所需的一切。

除了提供已有 MSP 设计资源的完整集合外，MSPWare 还包含名为 MSP 驱动程序库的高级 API。该库可简化针

对 MSP 硬件的编程。有关更多信息，请访问用于 MSP 微控制器的 MSP430Ware。

图 4-5. 使用 TI Resource Explorer 在 MSPWare 中浏览 MSP-EXP430FR5994

TI Resource Explorer 中还有很多此类示例和更多其他资源，只需点击一下鼠标即可将其轻松导入 CCS。
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4.4 FRAM 实用程序

Texas Instruments™ FRAM 实用程序是一个嵌入式软件实用程序集，其中的实用程序充分利用 FRAM 的超低功

耗和近乎无限次的写入寿命。这些实用程序适用于 MSP430FRxx FRAM 微控制器并提供示例代码来协助应用开

发。

4.4.1 Compute Through Power Loss (CTPL)

CTPL 是一种实用程序 API 集，能够确保方便使用 LPMx.5 低功耗模式和强大的关断模式；该关断模式使得应用

程序在检测到掉电时保存并恢复重要系统组件。

资源 www.ti.com.cn
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4.5 MSP430FR5994 MCU
4.5.1 器件文档

有时，您可能需要有关 MSP430FR5994 MCU 的更多信息。对于每个 MSP 器件，文档的组织组织结构如表 4-1 
所示。

表 4-1. MSP 器件文档的组织结构

文档 对于 MSP430FR5994 说明

器件系列用户指南
MSP430FR58xx、MSP430FR59xx 和 MSP430FR6xx 
系列用户指南

器件的架构信息，包括所有模块和外设（如时钟、计时

器、ADC 等）。

器件特定的数据表 MSP430FR599x、MSP430FR596x 混合信号微控制器 器件特定的信息和该器件的所有参数信息

4.5.2 MSP430FR5994 代码示例

MSP430FR599x、MSP430FR596x 代码示例是一组简单的 C 语言示例，演示了如何通过直接寄存器访问使用整

套 MSP430 外设（包括串行通信、ADC12、LCD_C、Timer_A、Timer_B 等）。

每个 MSP 衍生器件都有一组上述代码示例。启动新工程或添加新外设时，这些示例是很好的起点。节 4.3 还提供

了基于 MSP 驱动程序库的代码示例。

4.5.3 MSP430 应用手册和 TI 参考设计

请访问 www.ti.com/msp430 以获取大量的应用手册和参考设计以及实用设计示例和主题。

4.6 社区资源

4.6.1 TI E2E™ 支持论坛

请在 e2e.ti.com 上搜索论坛。如果您找不到问题的答案，可以向 TI 专家发布您的问题。

4.6.2 其他支持社区

许多在线社区都关注 LaunchPad 开发套件（例如 http://www.43oh.com）。您可以在这些社区中找到更多工具、

资源并获得支持。
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5 常见问题解答

Q：我无法连接反向通道 UART。怎么了？

答：请检查以下各项：

• 主机终端应用程序中的波特率与 eUSCI 设置是否匹配？
• 隔离跳线块上的相关跳线是否到位？
• 探测 RXD 并从主机发送数据。如果您没有看到数据，则可能是主机侧的问题。

• 探测 TXD，同时从 MSP 发送数据。如果您没有看到数据，则可能是 eUSCI 模块的配置问题。

• 可考虑使用硬件流控制线（尤其是波特率较高时）。

Q：MSP G2 LaunchPad 有一个插座可用于更改目标器件。为何该 LaunchPad 套件不使用此插座？

答：该 LaunchPad 开发套件提供更多功能，这意味着使用的器件具有更多引脚。用于具有如此多引脚的器件的插

座对于 LaunchPad 开发套件的目标价格而言太贵。

常见问题解答 www.ti.com.cn
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6 原理图
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图 6-1. 原理图 (1/7)
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图 6-2. 原理图 (2/7)
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图 6-3. 原理图 (3/7)

www.ti.com.cn 原理图

ZHCUAO6C – MARCH 2016 – REVISED NOVEMBER 2022
Submit Document Feedback

MSP430FR5994 LaunchPad™ 开发套件 (MSP‑EXP430FR5994) 35

English Document: SLAU678
Copyright © 2022 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUAO6
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUAO6C&partnum=MSP-EXP430FR5994
https://www.ti.com/lit/pdf/SLAU678


Copyright © 2016, Texas Instruments Incorporated

图 6-4. 原理图 (4/7)
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图 6-5. 原理图 (5/7)
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图 6-6. 原理图 (6/7)
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图 6-7. 原理图 (7/7)
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